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Overview of Features

· Separate input and output windows, avoiding the most annoying aspect of using telnet,    in which 
the incoming text is interspersed with what you type.

· Multiple hosts in different windows active simultaneously, allowing you to lurk on several hosts at 
the same time.

· Easy to use, remembers MUD names, host addresses, ports, and optionally passwords, and other 
logon text.

· Scroll back buffer, eliminating the need for page pausing on the mud server side.
· Advanced Triggers that support sound events, allowing you to wait for your favorite person to log 

on, and be notified by sound, eliminating the need to watch over the computer screen.
· Macros, and a dockable/floating macro bar.
· ANSI color support. (not vt100 or ANSI cursor positioning).
· Multiple Macro / Trigger / Alias sets for using multiple MUDs / logins.
· Active hosts window, which allows you to see which hosts you are connected to, and which have 

new activity since you last viewed that window. You may also switch between them by clicking on 
the hosts.

· Fully asynchronous sockets programming model, not locking up your computer while waiting for a 
network event to occur.

· User selectable fonts. ( Courier or other non-proportional fonts only to allow for proper positioning 
of on-line ASCII art.)

· Several word wrapping options including 80 columns / window size, and character    or word 
wrapping.

· Floating / dockable toolbar allowing easy access to common commands.
· Win32 programming model for added robustness.
· User selectable colors foreground / background.
· Pause.    Pauses text display.
· Log Files - Allows all text to be written to a file.
· Copy from Output window.    Select text with left mouse button, release left mouse button to copy 

to clipboard.
· Paste File Option.    Sends a text file out to the MUD.
· Aliases - Allowing you to create your own commands / shortcuts
· Command Stacking- execute multiple commands at one time.
· Speed Walking  - A popular feature that allows you to get from point a to point b quickly.

Possible Future Features



Installation/Setup
Setup of GMUD is fairly easy. 

1. Copy    GMUD to its own directory, or unzip the archive there to start with.
2. Add the executable to a program group, or in Win95 drag the executable from the explorer and drop it on the

desktop. 
3. Ensure that you Winsock connection is active.
4. Double click on the Icon to Run GMUD.



Using Auto Login
In the Edit World dialog box there is an edit control titled "Text to output upon connect". To have the 
client automatically log you in upon connect, insert the appropriate connect string, i.e. 

connect username password      
(where username and password are YOUR username and password :))

Or on Diku/Merc    type MUDS, just enter

username
password

Multiple lines are allowed, with carriage returns, enabling you to login, then automatically execute mud
commands. (like having a list of who's on-line printed out, etc.)



Triggers
A trigger is an action by the client (GMUD) that is triggered by text that is received from the mud 
server. You have to enter in the trigger text box the text that you want GMUD to look for to initiate the 
event. When the mud client receives this text, it will send the text that you have entered in the output 
text box to the mud server, and play the sound file you have selected. Please note that both the output
text and sound file are optional.

You may select a small sound file (small enough to fit into memory all at once) to play when GMUD 
detects the trigger string. The uses of this are enormous... you can use it to wait for people to log on, 
or notify you when someone pages you, or when you receive mail, or to just spice up the game on 
combat muds by having different sounds play for different combat hits (kicks, deaths, backstabs, 
DECIMATE vs. ANIHHILATE, etc.) with a little creativity, it can start to sound like you're playing DOOM 
or something :)

You can have multiple sets of triggers, mostly useful for having one set for each type of MUD... the 
same set can be used in multiple muds if you wish. To change the trigger set that you are using for a 
particular MUD, use the Connect Dialog, or the Edit World List dialog

Advanced Triggers
Advanced triggers let you create a trigger that will respond to the mud in the context of the triggered 
text. To indicate a match on any word in the trigger text, use an *. To then place that word in the text 
that is sent back to the mud, use %n, where n represents the specific number (1-9) of the matched 
word you wish to send back to the mud. you can use up to 9 parameters this way.

Example:
If the mud sent you the text: bill slaps sally

And your advanced trigger text was: * slaps * 
And your mud output was: tell %1 Its not nice to slap %2

Your trigger would respond: tell Bill Its not nice to slap sally

A trigger can only span one line of input text, but can have multiple output lines of text. On combat 
muds, allot of times monsters will flee from you, and you will have to chase after them. If you wanted 
to automate it, you could do something as follows:

Example:
If the text you received was something like: The Monster wimps out and flees east.

You might set your trigger to: * wimps out and flees *
And your mud output to: %2

kill %1

And the trigger would send to the mud: east
kill Monster

Obviously, triggers are a very powerful way to automate your mud sessions, and can add allot of spice 
to your game.

See also: Exporting / Importing Your Sound / Trigger set 
How GMUD does trigger matching



keyboard Commands
This list is by no means complete, All of the standard Windows keyboard equivalents apply mostly just 
the ones I get asked about.

CTL-TAB Switch windows (worlds).
CTL-F4 Close the currently active window.
ALT-F4 Exit the program.
CTL-V Paste text into the input window.
CTL-C Copy text from the input window.

Up-Arrow Show the previous command(s) (may be used multiple 
times).

Down-Arrow Show the next command(s) (may be used multiple times).
Page-Up Scroll backwards in scroll-back buffer.

Page-Down Scroll forwards in scroll-back buffer

Troubleshooting Problems
I get a GPF when GMUD starts

You are probably using windows 3.1(1) and an old version of Win32s. Upgrade to at least Win32s version 
1.25. In the future, GMUD will require Win32s 1.3, so its best to upgrade to that.

I can't connect to any host under Windows95 or Windows NT or
I get a DNS Lookup failure.

Are you running a 16 bit Winsock driver?
Windows 3.1(1) with Win32s will convert 32 bit apps to use the 16 bit Winsock, and Win95 won't :(... you 
have to upgrade to a 32 bit Winsock program. If you are having problems installing a 32 bit Winsock 
program, you might want to try installing the internet support in the Microsoft plus pack for Windows 95, or 
the Remote Access internet support under Windows NT.

If that doesnt work, make sure you have the Hostname in the appropriate field in the connect dialog. Dont 
just put it in the field for the muds name.

None of the sounds work (Trigger sounds don't work)
They might be disabled under the Edit/Sounds settings dialog.

ANSI colors look weird in scroll-back or when another window is moved over the GMUD window.
This is a known problem, the effect is of minor cosmetic inconvenience, and the programming effort required
to fix it is major... it will be a while before I get around to this one.

The ANSI logon picture on my mud looks messed up.
The picture requires ANSI Cursor positioning support which GMUD does not (yet)
support .The    program should work fine once you are in the mud.

Background color is different from text background.
The ANSI standard requires the text background to be black by default.
If you select a non-black background in the color dialog, things will look funny.
either disable ANSI, or select a black background.



This program is Share-Ware

If you use this program regularly, and wish to see it's features expand, or wish to see similar quality 
software developed in the future, 

Send $20 to : 

Dan Kelly
1136 Mellon Street Apt #1
Pittsburgh, PA 15206-1526

Thank you for your continued support.

Distribution
This program is freely distributable, and a small copying fee may be charged. For Site licenses, 

or if you wish to include this program as part of your internet software suite, or purchase the source, 
with our without ownership of the product, please contact me, prices are reasonable. If you have a 
Win-32 based program that you need constructed, please contact me for a price quote.

Send bug reports / feature enhancement requests / Ideas to
Entropy@infobahn.icubed.com.

You don't have to register to receive support.

Get the latest version at: ftp://papa.indstate.edu/winsock-l/mud
This is an excellent FTP site, with just about everything thats out there for winsock.



Aliases
Aliases give you the power to create your own commands, or just shortcuts to lengthy commands. You 
enter your alias text to name the command shortcut you are making, this is the text you will type to 
activate the alias. in the Alias Translation field, you enter the resultant text that will be sent to the 
mud.

Example:
If you often had to type in the following : cast cure light player

You might set your alias text to : cure
and your alias translation to : cast cure light

then every time you typed : cure player
the client would send to the mud: cast cure light player

Be careful that you dont set aliases for commonly typed words... for instance, you wouldnt want to set 
an alias text to sleep, because every time you tried to sleep, your alias would get executed instead.



Macros
A macro is a string of user-specified text that will be sent to the mud when you hit a function key (F1-
F10). To edit them, hit the Macro button on the toolbar, or use the Edit/Macros menu combination. their
usage is fairly straight forward. You may have multiple sets of macros for different muds/ characters.



Telnet
Telnet is a command line utility that is used to communicate with a remote host. The standard UNIX 
telnet command is of limited use for mudding.



ANSI Color
ANSI color is a method of transmitting color information from the host to the client. ANSI stands for the
American National Standards Institute.



VT100
VT100 is a protocol developed by DEC that allows the server program to move the cursor on the clients
screen.



MUD
A MUD is the server (commonly referred to as a World, or a Host) that controls the text based virtual 
reality. The MUD acronym has several translations, the most common being Multi User Dungeon. There
are many types of MUDs, but for the purposes of this help file, MUD refers to any text based virtual 
reality.



Command Stacking
Command stacking allows you to enter multiple commands in one line of text. The command separator
character is the semicolon. Command stacking works in macros, aliases, and triggers as well as from 
the keyboard.

Example:
If you typed : stand;n;e;s;u;kill baddie

The client would send : stand
n
e
s
u
kill baddie

Command stacking may be disabled (in case the mud requires you to enter a semicolon character) 
Under the Options menu.



Speed Walk
Speed walking (a highly requested feature) is used to get from point a. to point b. quickly. It is 
activated by typing the speed walk prefix followed by a string of directional commands. You can also 
use numbers to move a number of times in a specified direction.

Example:
If your speed walk prefix was : /w

And you typed : /wes2nu2w1d
The client would output to the mud : east

south
north
north
up
west
west
down

Care must be taken when setting the speed walk prefix. If you were to use say w as your speed walk 
prefix, then whenever you typed who, it would get misinterpreted as a speed walk, and the client 
would complain about a bad speedwalk string, and you wouldnt see who was on...



Directional Commands
N-North
S-South
E-East
W-West
U-Up
D-Down

If you know of other directional commands I'm missing, please contact me.



Possible Future Features
Notable MISSING features to be implemented in a possible future version include :

· Scripting
· A version of GMUD designed exclusively for Win95
· VT100 support. This version will be much slower, and will be limited to 80x25 columns



Known Bugs

· While the display is scrolling, the input window is inactive.
· When a Maximized child window is in the background, and text is set to wrap to the screen width, it

will wrap to the non-maximized size.
· ANSI colors may be off slightly in the scroll-back buffer.
· Problems with the alpha version of NT351's Chicago style shell, think it's the shell's fault...



New Features
Bug Fixes / enhancements from 1.9a to 1.9b (October 24, 1995)

Better buffering of pasted text, and fast typing.
Fixed a few abnormalities in the trigger matching routines, it's not perfect, but better, see 

online help for more info
Added dim colors to the color change dialog box.
Fixed a few other small bugs.
Made it so C/Rs aren't inserted into mud prompts if local echo is turned off.
Fixed ANSI Color handling when you select a different background / foreground color (once and 

for all).
Made input window reflect changes in selected font.
Line spacing is closer, allowing you to see more.
Separator line is smaller, allowing you to see more.

Bug Fixes / enhancements from 1.8b to 1.9a (October 15, 1995)
Added This nifty help file, and made it show up onscreen the first time you run GMUD after it had been 
changed :).
Added Advanced triggers.
Added speed walking, enable from the commands menu.
Added command stacking, disable from the options menu if you don't want it.
Due to a bug in deleting trigger/macro/alias sets, it was possible to delete the default set, and that caused 
really bad problems all throughout the program... I fixed the bug, and built a routine to salvage your datafile if
this had happened to you... Yikes, I hate this type of bug!
Fixed not saving world info when ya hit exit.
Re-worked Trigger dialog to avoid confusion for the user.

Bug Fixes / enhancements from 1.8a to 1.8b
Fixed nasty bug when you add a new world you couldn't type anything! :P.
Added capability to load / save trigger packages, should be cool :)
Changed handling of connect / disconnect functions to allow aborting connect retries.
fixed carriage returns when you copy from the output window.
Allowed multiple lines pasted into the input window... works logically...

Bug Fixes / enhancements from 1.7b to 1.8a
Added Aliases :) About the only 2 major omissions from the client's 
feature list now, are scripting, and VT100.
Changed Menu item arrangement, was getting out of hand from spec creep.
Modified handling of ANSI when a wierd foreground / background color combo was selected.
Tweaked program Icons.
Changed order of toolbar buttons, added macro window button.

Bug Fixes / enhancements from 1.7a to 1.7b
Last minute bug when users had no worlds... fixed.

Bug Fixes / enhancements from 1.5a to 1.7a
Added Local Echo option, which toggles wether commands you type are printed in the 
output window... If your mud is already echoing what you type, disable this option.
Minor reworking / spell checking of document.
I think there was this silly message in 1.5a's dialog box, it's fixed now.
Added Paste File option
Added Copy from output window, made it automagically pause and unpause, just use left
mouse button, and it auto-copys when you let up on the mouse button.
Added Pause Option
Added Log to File option.
Changed from sending NL/LF to NL when you hit enter key, was causing probs on some muds.
Added Command line parameters, format:
gmud worldname    (connects to the world name) or
gmud host port (Adds the world to the world list and connects to it.)

Bug Fixes / enhancements from 1.0c to 1.5a
Added multiple trigger / macro setups
moved data file back to GMUD directory
Added description field to worlds
Dialogs went through minor rework
Fixed rare GPF in connect dialog.
fixed bug causing sound for triggers when no sound was selected.
lots of little bugs / anomalities fixed



Minor upgrades to documentation.
TONS of stuff that I can't remember now...

Bug Fixes / enhancements from 1.0b to 1.0c
corrupt .rc file left out menu option for showing macro bar.

Bug Fixes / enhancements from 1.0a to 1.0b
ANSI Color! Yeah :)
fixed bug allowing you to enter a blank world name.
fixed bug where name server would fail if there were extra spaces after host name.
alot more small bugs fixed.
hopefully not too many bugs introduced with ANSI...

Bug Fixes / enhancements from 0.9b to 1.0a
Changed file naming convention to GMD32XXx.ZIP
where XX is major/minor version number, 
and x is alphabetic bug fix / confidence level release:)
Added more buttons to the toolbar to represent common GMUD functions.
Added option to wrap options dialog to indent wrapped lines.
Fixed a bizzare bug that wouldn't let it save foreground color of black.
Increased scrollback buffer size to 500 lines.
Further increased output window speed, and input window response time.

Bug Fixes / enhancements from 0.8a to 0.9b
fixed another problem with muds that prompt.
Added connected worlds list, showing which worlds have had activity,
and allowing the user to switch between them by clicking on the list.
fixed bug not allowing numeric addresses.
Email address of author changed to Entropy@infobahn.icubed.com



Exporting / Importing Your Sound / Trigger set
A GMUD Trigger pack (*.gtp) consists of all of your sound files, and trigger texts, and mud output texts 
in 1 file. The reason for using a GTP file is so that you can save all your neat triggers with their sounds, 
and upload them to the FTP site for your favorite mud. Then someone else on your mud can download 
that pack (along with GMUD of course :)) and have a nifty sound set without having to go through all of
the hastles and pains of collecting the sound files themselves. I made a few Trigger/Sound sets for my 
personal use, but havnt really had the time to go out and find all the sound files and set them up... (If 
anyone does a nice set for mystic adventure, please email it to me, or upload it to the site listed in 4. 
below:))

The procedure for exporting is as follows:

1. Select Export Sound Pack from the File menu.
2. Select the Trigger set youre going to export. (Only this set will be exported.)
3. Type in a name for the file youre going to export to. (Please use the *.GTP naming convention.)
4. Basically Youre done. All you have to do now, is to ZIP up the pack, and upload it to your favorite 

MUDs FTP site. If your favorite mud doesnt have an FTP site, you can upload it to 
ftp://papa.indstate.edu/winsock-l/incoming, with a short text file telling which MUD it relates to ( and which 
mud types) included in the zip. It will appear in ftp://papa.indstate.edu/winsock-l/mud/GMud32.Triggers/ 
Many thanks to The BEAST at papa.indstate.edu for generously providing such a service to me and to all of us.

Notes about Exporting

Make SURE you dont have anything personal in the trigger set before you export it. Examples include : 
on password put mypassword type triggers.

Be sure to share your trigger pack by uploading it with a text file naming

1. That it is in fact a GMUD Trigger Pack.
2. The Name, address, and port of the mud it was designed under.
3. The type of mud (or something like merc derivitive... or MOO, Lamda Core etc.)
4. The FTP site for GMUD (ftp://papa.indstate.edu/winsock-l/mud )

Upload to your muds FTP site, AND the GMUD GTP repository at: 
ftp://papa.indstate.edu/winsock-l/incoming

The procedure for Importing is:

1. Select Import Sound Pack from the File menu.
2. If everything goes well, youre done.

Notes about Importing

The original trigger set name is stored in the .gtp file, and will be restored when you import the trigger 
pack. If that trigger set already exists, the new set will be renamed with a 1 added to the end of it (or a
2, or 3, etc...). The sound files will be placed in the Sounds directory under the GMUD directory. If a 
sound file with that name already exists in the sounds directory, that sound file will be skipped.

If you wish to specify a different directory to keep your sound files in, Edit the [Sounds] directory= 
entry in GMUD32.ini. I will be putting in a menu option to change this in the near future, but for now, 
you have to edit the .ini file.

You should be able to find Gmud Trigger Packs at ftp://papa.indstate.edu/winsock-l/mud/GMud32.Triggers/  
In the near future

If any of these addresses happen to expire by the time you read this (Mebby years after I wrote this) You could also 
Email me (Entropy@infobahn.icubed.com), or check the GMUD WWW page 
(http://oeonline.com/~morton/gmud.html).



See Also: How GMUD does trigger matching
Triggers



How GMUD does trigger matching

GMUDs trigger matching can be generalised by saying it is word based, and ignores punctuation, and 
case.

Therefore, a trigger of    connected will not match on the mud text of disconnected .

The following punctuation characters are ignored (actually, they are treated as word separators) in 
trigger matching.

'`?!.,;:" the Space, tab, carriage return, and newline.

Therefore, the following phrases are all equivalent to the trigger matching routine

joe says Hi

Joe says "HI!"

joe says, hi

"joe says;hi;

joe                says Hi !

The reason punctuation is ignored is best illistrated by the first 2 examples above.

If you for some reason have additional punctuation that needs to be ignored that Ive missed, or youve 
found a situation that does not follow these rules (a bug in gmud), Please email me about it.

See Also: Exporting / Importing Your Sound / Trigger set
Triggers

 




